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END-USER LICENSE AGREEMENT FOR GECKO SOFTWARE 
 
IMPORTANT-READ CAREFULLY: This Gecko End-User License Agreement 
("EULA") is a legal agreement between you (either an individual or a single entity) 
and Gecko Software, Inc., corporation for the Gecko software product identified 
above, which includes computer software and may include associated media, 
printed materials, and "online" or electronic documentation and data ("SOFTWARE 
PRODUCT"). The SOFTWARE PRODUCT also includes any updates and 
supplements to the original SOFTWARE PRODUCT provided to you by Gecko. Any 
software provided along with the SOFTWARE PRODUCT that is associated with a 
separate end-user license agreement is licensed to you under the terms of that 
license agreement. By installing, copying, downloading, accessing or otherwise 
using the SOFTWARE PRODUCT, you agree to be bound by the terms of this 
EULA. If you do not agree to the terms of this EULA, do not install or use the 
SOFTWARE PRODUCT; you may, however, return it to your place of purchase for 
a full refund. 
 
SOFTWARE PRODUCT LICENSE 
 
The SOFTWARE PRODUCT is protected by copyright laws and international 
copyright treaties, as well as other intellectual property laws and treaties. The 
SOFTWARE PRODUCT is licensed, NOT SOLD! 
 
1. GRANT OF LICENSE. This EULA grants you the following rights: 
Track 'n Trade Software. You may install and use one copy of the SOFTWARE 
PRODUCT on two desktop systems, and one laptop system. (Intended for one copy 
at work, one copy at home, and one copy for travel.) You may not allow remotely 
connected COMPUTERS, nor to invoke application sharing of the software. This 
connection includes any indirect connections made through software or hardware 
which pools or aggregates connections. This multi-station license agreement allows 
you to personally use the software while at home, work or on the road; this is not 
the right to lend out copies of this software to your friends and family. Even though 
you are allowed to install the SOFTWARE on multiple workstations, the 
SOFTWARE can only be executed and running on one COMPUTER at a time; no 
simultaneous use is allowed without the purchase of additional licenses. 
 
Storage/Network Use. You may also store or install a copy of the SOFTWARE 
PRODUCT on a storage device, such as a network server, used only to install or 
run the SOFTWARE PRODUCT on your other COMPUTERS. 
License Pak. If this package is a Gecko License Pak, you may install and use 
additional copies of the computer software portion of the SOFTWARE PRODUCT 
up to the number of copies specified above as "Licensed Copies". 
 
2. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS 
Academic Edition Software. If the SOFTWARE PRODUCT is identified as 
"Academic Edition" or "AE," you must be a "Qualified Educational User" to use the 
SOFTWARE PRODUCT. If you are not a Qualified Education User, you have no 
rights under this EULA. Furthermore, you are only allowed to install the 
SOFTWARE PRODUCT on one single COMPUTER, not the three systems as 
described above. To determine if you are a Qualified Educational User, please 
contact the Gecko Sales Information Center in the USA at 435-752-8026. 
 
Not For Resale Software. If the SOFTWARE PRODUCT is labeled "Not For Resale" 
or "NFR," then, notwithstanding other sections of this EULA, your use of the 
SOFTWARE PRODUCT is limited to use for demonstration, test, or evaluation 
purposes and you may not resell, or otherwise transfer for value, or install the 
SOFTWARE PRODUCT on more than one single COMPUTER. 
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Limitations on Reverse Engineering, Decompilation, and Disassembly. You may not 
reverse engineer, decompile, or disassemble the SOFTWARE PRODUCT, except 
and only to the extent that such activity is expressly permitted by applicable law 
notwithstanding this limitation. 
 
Separation of Components. The SOFTWARE PRODUCT is licensed as a single 
product. Its component parts may not be separated. 
 
Rental. You may not rent, lease or lend the SOFTWARE PRODUCT. 
 
Trademarks. This EULA does not grant you any rights in connection with any 
trademarks or service marks of Gecko Software, Inc. 
 
Support Services. Gecko may provide you with support services related to the 
SOFTWARE PRODUCT ("Support Services"). Use of Support Services is governed 
by the Gecko polices and programs described in the user manual, in "on line" 
documentation and/or other Gecko-provided materials. Any supplemental software 
code provided to you as part of the Support Services shall be considered part of the 
SOFTWARE PRODUCT and subject to the terms and conditions of this EULA. With 
respect to technical information you provide to Gecko as part of the Support 
Services, Gecko may use such information for its business purposes, including for 
product support and development. 
 
Software Transfer. The user of the SOFTWARE PRODUCT may make a one-time 
permanent transfer of this EULA and SOFTWARE PRODUCT only directly to an 
end user. This transfer must include all of the SOFTWARE PRODUCT (including all 
component parts, the media and printed materials, any upgrades, this EULA, and, if 
applicable, the Certificate of Authenticity). Such transfer may not be by way of 
consignment or any other indirect transfer. The transferee of such one-time transfer 
must agree to comply with the terms of this EULA. 
Even though we have given the right to transfer the software application license, we 
do not give the right to transfer data subscription services.  Data subscription 
services are non-transferable. 
 
Termination. Gecko Software, Inc. may terminate your license and this EULA at any 
time for any reason what so ever; without the obligation of reimbursement or 
compensation.  Therefore, if Gecko gives notice of termination of your license, or 
you fail to comply with the terms of use set forth in this agreement, you must 
destroy all copies of the SOFTWARE PRODUCT and all of its component parts. 
 
3. UPGRADES. If the SOFTWARE PRODUCT is labeled as an upgrade, you must 
be properly licensed to use a product identified by Gecko Software, Inc. as being 
eligible for the upgrade in order to use the SOFTWARE PRODUCT. A SOFTWARE 
PRODUCT labeled as an upgrade replaces and/or supplements the product that 
formed the basis for your eligibility for the upgrade. You may use the resulting 
upgraded product only in accordance with the terms of this EULA.  
 
4. COPYRIGHT. All title and intellectual property rights in and to the SOFTWARE 
PRODUCT (including but not limited to any images, photographs, animations, 
video, audio, music, text, and "applets" incorporated into the SOFTWARE 
PRODUCT), the accompanying printed materials, and any copies of the 
SOFTWARE PRODUCT are owned by Gecko Software, Inc. or its suppliers. All title 
and intellectual property rights in and to the content which may be accessed 
through use of the SOFTWARE PRODUCT is the property of the respective content 
owner and may be protected by applicable copyright or other intellectual property 



 

Track ‘n Trade Pro 4.0 User Manual                                                             12 

laws and treaties. This EULA grants you no rights to use such content. All rights not 
expressly granted are reserved by Gecko Software, Inc. 
 
5. DUAL-MEDIA SOFTWARE. You may receive the SOFTWARE PRODUCT in 
more than one medium. Regardless of the type or size of medium you receive, you 
may use only one medium that is appropriate for your computer. You may not loan, 
rent, lease, lend or otherwise transfer the other medium to another user, except as 
part of the permanent transfer (as provided above) of the SOFTWARE PRODUCT. 
 
6. BACKUP COPY. After installation of the SOFTWARE PRODUCT pursuant to this 
EULA, you may keep the original media on which the SOFTWARE PRODUCT was 
provided by Gecko solely for backup or archival purposes. If the original media is 
required to use the SOFTWARE PRODUCT on the COMPUTER, you may make 
one copy of the SOFTWARE PRODUCT solely for backup or archival purposes. 
Except as expressly provided in this EULA, you may not otherwise make copies of 
the SOFTWARE PRODUCT or the printed materials accompanying the 
SOFTWARE PRODUCT. 
 
7. U.S. GOVERNMENT RESTRICTED RIGHTS. All SOFTWARE PRODUCT 
provided to the U.S. Government pursuant to solicitations issued on or after 
December 1, 1995 is provided with the commercial license rights and restrictions 
described elsewhere herein. All SOFTWARE PRODUCT provided to the U. S. 
Government pursuant to solicitations issued prior to December 1, 1995 is provided 
with "Restricted Rights" as provided for in FAR, 48 CFR 52.227-14 (JUNE 1987) or 
DFAR, 48 CFR 252.227-7013 (OCT 1988), as applicable. 
 
8. EXPORT RESTRICTIONS. You agree that you will not export or re-export the 
SOFTWARE PRODUCT, any part thereof, or any process or service that is the 
direct product of the SOFTWARE PRODUCT (the foregoing collectively referred to 
as the "Restricted Components"), to any country, person or entity subject to U.S. 
export restrictions. You specifically agree not to export or re-export any of the 
Restricted Components: (i) to any country to which the U.S. has embargoed or 
restricted the export of goods or services, which currently include, but are not 
necessarily limited to Cuba, Iran, Iraq, Libya, North Korea, Sudan and Syria, or to 
any national of any such country, wherever located, who intends to transmit or 
transport the Restricted Components back to such country; (ii) to any person or 
entity who you know or have reason to know will utilize the Restricted Components 
in the design, development or production of nuclear, chemical or biological 
weapons; or (iii) to any person or entity who has been prohibited from participating 
in U.S. export transactions by any federal agency of the U.S. government. You 
warrant and represent that neither the BXA nor any other U.S. federal agency has 
suspended, revoked or denied your export privileges. MISCELLANEOUS This 
EULA is governed by the laws of the State of Utah. If this product was acquired 
outside the United States, then local law may apply. Should you have any questions 
concerning this EULA, or if you desire to contact Gecko for any reason, please 
contact Gecko on the World Wide Web at: www.GeckoSoftware.com. 
 
LIMITED WARRANTY Gecko warrants that the SOFTWARE PRODUCT will 
attempt to perform in accordance to our advertisements for a period of thirty (30) 
days from the date of receipt.  If it does not perform to your expectation, the only 
guarantee Gecko Software gives is a refund of the purchase price paid for the 
application.  This warranty is only good for a period of 30-days from the date of 
purchase.  Gecko does not guarantee that any mathematical formulas are correct, 
or that any data is correct, or that any of the rules used to create the software to 
simulate real life situations are correct.  These are just our best guess, and you as 
the licensee of the software agree not to hold Gecko liable for any mistakes, 
discrepancies, inaccuracies or errors that may be included with the software 
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application, supporting materials, manuals, or supplemental products provided by 
Gecko Software, Inc. or its subsidiaries, groups, friends, associates, managers, 
employee's, spouses, or anyone else who lives on planet earth.  You agree to play 
with this software totally and 100% at your own risk.  This software application was 
written as a game, in an attempt to simulate real market situations and as an 
educational tool to practice such teachings and techniques; therefore you take upon 
yourself the total and entire risk of loss if you decide to actually use this software in 
an attempt to help you make any real life decisions -- whatever they may be. 
 
If an implied warranty or condition is created by your state/jurisdiction and federal or 
state/provincial law prohibits disclaimer of it, you also have an implied warranty or 
condition, BUT ONLY AS TO DEFECTS DISCOVERED DURING THE PERIOD OF 
THIS LIMITED WARRANTY (THIRTY (30) DAYS). AS TO ANY DEFECTS 
DISCOVERED AFTER THE THIRTY (30) DAY PERIOD, THERE IS NO 
WARRANTY OR CONDITION OF ANY KIND. Some states/jurisdictions do not 
allow limitations on duration of an implied warranty, so the above limitation may not 
apply to you. Any supplements or updates to the SOFTWARE PRODUCT, including 
without limitation, any (if any) service pack or hot fixes provided to you after the 
expiration of the thirty (30) day Limited Warranty period are not covered by any 
warranty or condition, express or implied. 
 
LIMITATION ON REMEDIES; NO CONSEQUENTIAL OR OTHER DAMAGES Your 
exclusive remedy for any breach of this Limited Warranty is as set forth below. 
Except for any refund elected by Gecko, YOU ARE NOT ENTITLED TO ANY 
DAMAGES, INCLUDING BUT NOT LIMITED TO CONSEQUENTIAL DAMAGES, if 
the SOFTWARE PRODUCT does not meet Gecko's Limited Warranty, and, to the 
maximum extent allowed by applicable law, even if any remedy fails of its essential 
purpose. The terms "Exclusion of Incidental, Consequential and Certain Other 
Damages" below are also incorporated into this Limited Warranty. Some 
states/jurisdictions do not allow the exclusion or limitation of incidental or 
consequential damages, so the above limitation or exclusion may not apply to you. 
This Limited Warranty gives you specific legal rights. You may have others that vary 
from state/jurisdiction to state/jurisdiction. 
YOUR EXCLUSIVE REMEDY Gecko and its suppliers' entire liability and your 
exclusive remedy shall be, at Gecko's option from time to time, (a) return of the 
price paid (if any) for, or (b) repair or replacement of, the SOFTWARE PRODUCT 
that does not meet this Limited Warranty and that is returned to Gecko with a copy 
of your receipt. You will receive the remedy elected by Gecko without charge, 
except that you are responsible for any expenses you may incur (e.g. cost of 
shipping the SOFTWARE PRODUCT to Gecko). This Limited Warranty is void if 
failure of the SOFTWARE PRODUCT has resulted from accident, abuse, 
misapplication, abnormal use or a virus. Any replacement SOFTWARE PRODUCT 
will be warranted for the remainder of the original warranty period of thirty (30) days. 
Outside the United States, neither these remedies nor any product support services 
offered by Gecko are available without proof of purchase from an authorized 
international source. To exercise your remedy, contact: Gecko Software, Inc., Attn. 
Gecko Sales Information Center at the Web address specified above. 
DISCLAIMER OF WARRANTIES The limited warranty that appears above is the 
only express warranty made to you and is provided in lieu of any other express 
warranties (if any) created by any documentation, packaging, or outside reseller 
advertisements or claims. Except for the limited warranty and to the maximum 
extent permitted by applicable law, Gecko and its suppliers provide the SOFTWARE 
PRODUCT and Support Services (if any) AS IS AND WITH ALL FAULTS, and 
hereby disclaim all other warranties and conditions, either express, implied or 
statutory, including, but not limited to, any (if any) implied warranties or conditions of 
merchantability, of fitness for a particular purpose, of lack of viruses, of accuracy or 
completeness of responses, of results, and of lack of negligence or lack of 
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workmanlike effort, all with regard to the SOFTWARE PRODUCT, and the provision 
of or failure to provide Support Services. ALSO, THERE IS NO WARRANTY OR 
CONDITION OF TITLE, QUIET ENJOYMENT, QUIET POSSESSION, AND 
CORRESPONDENCE TO DESCRIPTION OR NON-INFRINGEMENT WITH 
REGARD TO THE SOFTWARE PRODUCT. 
 
EXCLUSION OF INCIDENTAL, CONSEQUENTIAL AND CERTAIN OTHER 
DAMAGES To the maximum extent permitted by applicable law, in no event shall 
Gecko or its suppliers be liable for any special, incidental, indirect, or consequential 
damages whatsoever (including, but not limited to, damages for loss of profits or 
confidential or other information, for business interruption, for personal injury, for 
loss of privacy, for failure to meet any duty including of good faith or of reasonable 
care, for negligence, and for any other pecuniary or other loss whatsoever) arising 
out of or in any way related to the use of or inability to use the SOFTWARE 
PRODUCT, the provision of or failure to provide Support Services, or otherwise 
under or in connection with any provision of this EULA, even in the event of the 
fault, tort (including negligence), strict liability, breach of contract or breach of 
warranty of Gecko or any supplier, and even if Gecko or any supplier has been 
advised of the possibility of such damages. 
 
LIMITATION OF LIABILITY AND REMEDIES Notwithstanding any damages that 
you might incur for any reason whatsoever (including, without limitation, all 
damages referenced above and all direct or general damages), the entire liability of 
Gecko and any of its suppliers under any provision of this EULA and your exclusive 
remedy for all of the foregoing (except for any remedy of repair or replacement 
elected by Gecko with respect to any breach of the Limited Warranty) shall be 
limited to the greater of the amount actually paid by you for the SOFTWARE 
PRODUCT or U.S.$1.00. The foregoing limitations, exclusions and disclaimers 
described above shall apply to the maximum extent permitted by applicable law, 
even if any remedy fails its essential purpose. 
 
Hypothetical or simulated performance results have certain limitations. Unlike an 
actual performance record, simulated results do not represent actual trading. Also, 
since the trades have not actually been executed, the results may have over or 
under compensated for impact, if any, of certain market factors, such as lack of 
liquidity. No representation is being made that any account will or is likely to achieve 
profits or losses similar to those shown. The risk of loss in trading futures, stocks 
and options can be substantial; therefore only genuine "risk" funds should be used 
in such trading. Futures, stocks and options may not be suitable investments for all 
individuals and individuals should carefully consider their financial condition in 
deciding whether to trade. Option traders should be aware that the exercise of a 
long option would result in a futures or stock position. 
 
Gecko Software, Inc. at its discretion may, from time to time, contact you by 
telephone, fax, email, paper mail, express mail, etc. By agreeing to this EULA and 
installing this software, you are giving digitally written consent to receive telephone 
calls from Gecko Software, Incorporated, its affiliates, and associated vendors, and 
you wave your rights to any laws prohibiting Gecko from contacting you via 
telephone, fax, email, or any other method preferred by Gecko. 
Portions of the grid controls used in the data tab, broker's report, and Spreads 
module are copyright (c) 1998, Chris Maunder. 
 
DATA DOWNLOAD IS DEFINED AS: This is a non-guaranteed service, with no 
rights or privileges whatsoever, and is only an extension of the service provided by 
Track 'n Trade, and Gecko Software, Inc. not a standard feature. 
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SUBSCRIPTION BASED DATA DOWNLOAD IS DEFINED AS: Data in which 
Gecko Software provides by computer transmission services to their subscribing 
customers.  This service is not a guaranteed service, and may be discontinued or 
off line for any given period or amount of time without warranty or restitution.  Data 
subscription services and fees are a non-refundable, non-guaranteed extension of 
service provided by Gecko Software Inc. 
 
Data has been provided from sources believed to be reliable but no guarantee is 
made as to its accuracy, therefore use of this data in making real-life trading 
situations is strongly discouraged.  When trading "real" markets, consult a licensed 
brokerage firm to confirm ALL price action; always remember, this is a game, and 
the data provided is for simulation and practice purposes only.  This license does 
not give any recipient the right to re-transmit or re-distribute this data in any format 
whatsoever. Much of the options data provided by Gecko Software is not even real 
market data, but “fictitious data” generated by the Black and Scholes mathematical 
model, it is never recommended that you use Track ‘n Trade Pro options data as a 
reference to the actual “live” market data. 
Final Disclaimer: Track ‘n Trade pro and all plug-in modules were specifically 
designed for entertainment purposes only – have fun! 
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INTRODUCTION TO FUTURES 
The Basics of Futures Trading 
 
Introduction 

The Stock Market evolved into being a way for companies to raise 
capital.  By exchanging ownership in a company for cash, early 
business ventures were able raise capital to buy equipment, or 
build factories.  Companies hundreds of years ago, as well as 
today, primarily use the stock market as a means to raise capital.   

The modern futures market evolved not from a need to raise 
capital, but from a need to transfer risk.  The futures market 
makes it possible for those who wish to manage price risk 
(hedgers) to transfer that risk to those who are willing to accept it 
in the hopes of a profit (speculators).  

Futures markets are first and foremost a risk transference vehicle. 
Futures markets also provide price information that the world 
looks to as a benchmark in determining value of a particular 
commodity or financial instrument on any given day or at any 
specific time of the day. These benefits, risk transference, and 
price discovery, reach every sector of the economy of the world 
where changing market conditions create economic risk; including 
such diverse fields as agricultural products, foreign exchange, 
imports, exports, financing and investment vehicles. 

What are Futures? 
Futures contracts are standardized to meet the specific 
requirements of buyers and sellers for a variety of commodities 
and financial instruments. Quantity, quality, and delivery locations 
(all the essential ingredients) are pre-established. The only 
variable is price, which is discovered through an auction-like 
process on the trading floor of an organized futures exchange. 

For example, assume an individual buys one contract of March 
Corn at $2.25 per bushel on January 2nd, initiating a long 
position. This contract calls for the delivery of 5,000 bushels of 
Number 2 Yellow Corn seven days before the last business day of 
the delivery month (March) at an exchange-recognized facility. If 
on February 15th, the purchaser of the March Corn contract 
wishes to exit his position, he can do so by selling one March 
Corn contract.  

Assuming that the contract was sold at $2.45 per bushel, the 
holder of the March Corn contract would receive $1,000.00 before 
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broker commissions and fees for holding the position for six 
weeks:  

Profit or Loss = Sale Price – Purchase Price * # of bushels 
($2.45 - $2.25 = $0.20 * 5,000 = $1,000.00) 

Our person in this example is $1,000.00 richer for the experience, 
and has no further obligation in the Corn market because the sale 
of the March Corn futures contract at $2.45 per bushel offset the 
earlier purchase at $2.25 per bushel. 

Notice in this example, that all of the features of the contract were 
predetermined by the exchange except price. 

 Quantity: 5,000 bushels for Corn futures 
 Quality of the Corn: #2 Yellow 
 Delivery time: 7th to last business day of the contract month 
 Location: exchange-recognized warehouse or transfer 
station 

 
Because futures contracts are standardized (with the only variable 
being price) buyers and sellers are able to exchange one contract 
for another and actually offset their obligation to deliver or take 
delivery of the commodity underlying the futures contract. 

Offset means taking an equal and opposite position in the futures 
market to one’s initial position.   

Margins and Guaranteeing Futures 
The exchanges and their members are able to guarantee all 
trades because they require all parties in a transaction to deposit 
performance bond margins. 

Performance bond margins are financial guarantees required of 
both parties (buyers and sellers) of futures contracts to ensure 
fulfillment of the contract obligations. 

That is, buyers and sellers are required to take or make delivery of 
the commodity or financial instrument represented by the futures 
contract unless the position is offset before contract expiration. 

Before entering into a transaction, both parties have to post Initial 
Margin Requirement.  The Initial Margin Requirement is the 
amount of money a party must have on account with a clearing 
firm (your broker) at the time the order is placed. 

Initial margin funds must be on deposit before any trade can be 
accepted. Maintenance Margin is a set minimum margin (per 
outstanding futures contract) that a party to a futures contract 
must maintain in his/her margin account to hold a futures position. 
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Initial Margin Requirements vary from commodity to commodity, 
but are generally between 5% and 10% of the total value of the 
contract. 

For example, if March Corn futures are trading at $2.11/bushel, 
the initial Margin Requirement for CBOT Corn futures is $405.00 
per contract, with a maintenance margin requirement of $300.00.  
Our speculator would have to have at least $405.00 on deposit 
with his broker before he could enter the market.  He would need 
to have an account liquidating value of at least $300.00 per 
contract in order to stay in the position. 

Let’s assume that our speculator has $1,000 in his account and 
decides to buy 2 contracts of March Corn at $2.35/bushel on 
January 2nd.  He is able to buy 2 contracts of March Corn 
because he has more than the initial margin requirement of 
$810.00 ($405.00 initial margin x 2 contracts = $810.00).  With 
$50.00 round turn commission rate ($25.00 in, $25.00 out) our 
speculators broker would charge him $50.00 in commissions as 
well.  Assume that March Corn settled at his entry price of 
$2.35/bushel.  His account liquidating value would be $950.00, or 
$1,000.00 initial deposit - $50.00 commission to buy 2 contracts of 
Corn.  Since the liquidating value of the speculators account 
(Funds on Deposit + Open Position Profit or loss) is greater than 
the maintenance margin requirement of $300.00 per contract or 
$600.00 for 2 March Corn, he is able to stay in the trade. 

The next day, much to our speculators detriment, Corn prices 
drop by 5 cents.  Our speculator now has an open position loss of 
-$500.00 and an account liquidating value of $450.00 ($1,000.00 - 
$50.00 commission - $450.00 open position loss = $450.00).  
Since this value is less than the Maintenance Margin requirement 
of $300.00 per contract, or $600.00, our speculator is on a Margin 
Call. 

In order to keep the position, the speculator must either send 
enough money to bring the account back above the Initial Margin 
Requirement of $810.00 or liquidate the position.  The 
Maintenance Margin Requirement is the minimum amount of 
money, which must be in the account (including open position 
profits and losses) to maintain an open position in the futures 
market.  If the value of the account dips below this level, then the 
account holder must either send additional funds to his/her broker 
or liquidate the position.  Usually, traders have 5 business days to 
get funds posted to the account, but in some cases the brokerage 
firm may liquidate the futures positions in order to meet the Margin 
Call. 

Note: Brokerages have the right to liquidate your position 
immediately, and many may require you to wire funds immediately 
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to avoid liquidation.  Also be aware that margin requirements are 
subject to change without notice. 

Remember, Initial Margin is the minimum amount of money you 
must have in your account to open up a futures position. 
Maintenance Margin is the minimum amount of money you must 
have in your account to maintain the position. So in our Corn 
example, the initial margin was $405.00 per contract, meaning 
that a trader must have at least $405.00 per contract in his/her 
margin account before a Corn futures position can be entered 
into. After the position is entered into a balance of $300.00 per 
contract or the Maintenance Margin must be maintained in order 
for the position to be left open. If the available funds in the 
account (funds deposited + open position profit or loss) are less 
than the Maintenance Margin Requirement, then more funds must 
be deposited or the futures positions will be liquidated or offset by 
taking an opposite position in the futures market. 

Reminder:  Long or buy positions are offset or closed by selling, 
while short or sell positions are offset or closed out by buying. 

The dual margining system (initial and maintenance) of the futures 
market ensures that all positions are adequately financed, insuring 
the integrity of the futures market.  The exchanges set the 
minimum margin requirement based on the volatility and dollar 
value of the contract.  Margin levels are subject to change both up 
and down at the discretion of the Exchange.  Most brokerage 
firms charge the exchange minimum margin, but they are entitled 
to charge more, so be sure to check with your broker before 
entering into any futures transaction. 

The Long and Short of Trading 
There are two basic positions one can have in the futures 
markets:  

1. A long position entails the purchase of futures contracts in 
anticipation of rising prices. 

Purchasing a futures contract enters into a long position. Long 
positions are profitable if the underlying futures contract increases 
in price during the holding period. Selling the same quantity and 
contract month that one initially purchased offsets a long position. 
Long positions are typically used by consumers to hedge against 
rising prices, and initiated by speculators in anticipation of higher 
prices. 

 
2. A short position entails the sale of futures contracts in 
anticipation of lower prices. 
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A short position is entered into by initially selling a futures 
contract. In the futures market, unlike the stock market, it is just as 
easy to establish a short position as a long position. Short 
positions are profitable if the underlying futures contract 
decreases in price during the holding period. Buying the same 
quantity and contract month that you initially sold offsets your 
short positions.  If the resulting purchase price is less than the 
original sale price, a profit is achieved. However, if the resulting 
purchase price is greater than the original sale price, a loss is 
incurred. 

Commodity producers who wish to avoid potentially lower prices - 
as a short position increases in value and prices decline - usually 
establish short positions. Speculators anticipating lower prices in 
the future establish short positions. 

Calculating Profit/Loss: 
To figure out the profit or loss associated with a position is the 
same regardless of either a long or short position.  The profit or 
loss from a futures position is calculated as follows: 

Profit or Loss = Sell Price – Buy Price x Contract Size x Number 
of Contracts 

For example, assume a speculator thinks that Corn prices will go 
down in the coming weeks.  As such, he sells 2 March Corn 
contracts at 235 ($2.35 per bushel, but corn prices are quoted in 
cents per bushel, so the price is said to be 235 cents per bushel), 
thus initiating a short position. 

Having studied the behavior of Corn, using his Track ‘n’ Trade 
software, our speculator was correct, and Corn prices fell from 
235 to 220 over the next two weeks.  Given the –15 cent drop in 
Corn prices, our speculator has a $1,500.00 open position profit, 
and decides to “cash in” his winning by buying 2 March Corn 
futures at 220. 

Profit or Loss = Sell Price – Buy Price x Contract Size x 
Number of Contracts 

= 235 – 220 = +15 cents 

= $0.15 x 5,000 bushel contract size = $750.00 per contract 

= $750.00 per contract x 2 contracts = $1,500.00 (before 
commissions and fees.) 

Now assume that another speculator buys (initiating a long 
position) 2 March Corn at 235.  After two weeks, prices again drop 
by –.15 cents to 220, at which time he offsets the long position by 
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selling 2 March Corn at 220.  His loss from the transaction would 
be -$1,500.00before commissions and fees.  

Profit or Loss = Sell Price – Buy Price x Contract Size x 
Number of Contracts 

= 220 – 235 = +15 cents 

= -$0.15 x 5,000 bushel contract size = $750.00 per contract 

= -$750.00 per contract x 2 contracts =- $1,500.00 (before 
commissions and fees.) 

As you can see, whether you are long or short, the basic idea of 
speculating in the futures market is to “BUY LOW” and “SELL 
HIGH.”  In the futures market this can be done in any order.  You 
can initiate a Long Position by buying the futures first and then at 
a later time offsetting by selling, and you profit if the sale price 
(exit price) is higher than the purchase price (entry price).  Or, you 
can initiate a Short Position by selling the futures first and then 
offsetting the contract(s) at a later time by buying them.  A profit 
will still occur if the sale price (entry price) is higher than the 
purchase price (exit price). 

Of course the profit or loss amount is determined by the contract 
you are trading.  Each market is quoted differently.  Some markets 
are quoted in points, while others are quoted in cents. 

 
 
Points vs. Cents:  

Quoting Prices and Calculating Profit or Loss 
Each futures contract is quoted in a slightly different manner, and 
as such your profit or loss calculation for most markets is slightly 
different.  The following is a basic highlight of the major markets 
and how they are quoted.  Of course, Gecko Software’s Track ‘n 
Trade® Pro charting software has tools to convert price moves to 
profit or losses, but we thought we would show you a few 
examples so you can understand how they are quoted. 

Grains:  
Corn, Wheat, Oats, and Soybeans are quoted in cents per bushel.  
The contract size for all of these is 5,000 bushels.  For example, a 
Corn price of 235 is really $2.35 per bushel. Each of these grains 
moves in 1/4-cent increments, which equates to $12.50 before 
commissions and fees.  Profit or loss of 1 cent move = $50.00 
before commissions and fees.  

Meats:   
The contracts are quoted in cents per pound.  So if Live Cattle is 
trading at 74.00, the price is actually 0.74 cents per pound.  Meat 
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prices move in 0.025 cents per pound increments, but usually the 
last 0.005-cent per pound is dropped, so a price quote of 74.02 is 
really 74.025, while a price quote of 74.17 is actually 74.175.  Live 
Cattle, Lean Hogs and Pork Bellies contracts all call for delivery of 
40,000 pounds, thus a 0.025-cent per pound is worth $10.00 
before commissions and fees.  Profit or loss of a 1 cent move = 
$400.00 before commissions and fees.  Feeder Cattle prices are 
quoted the same way, except that Feeder Cattle futures call for 
50,000 pounds, thus a 0.025 cent move is worth $12.50 and a 1 
cent move in Feeder Cattle = $500.00 before commissions and 
fees. 

"Softs" or Exotics:   
Coffee, Sugar and Orange Juice are all quoted in cents per 
pound, but each has a different contract size.  For example, a 
Coffee price of 50.40 is 50.40 cents per pound, while an Orange 
Juice price of 89.95 is 89.95 cents per pound, and a Sugar price 
of 762 is really 7.62 cents per pound (decimal is moved over in 
Sugar, as prices are quoted in cents per hundred weight).  Now, 
just to confuse everyone, Cocoa prices are quoted in dollars per 
metric ton, so a price of 1301 is really $1301 per ton. 

The contracts size for Coffee is 37,500 pounds, so a 1-cent move 
is worth $375.00 before commissions and fees.  Orange Juice 
futures call for delivery of 15,000 pounds so a 1-cent move is 
worth $150.00 before commissions and fees.  Sugar is traded in 
112,000-pound increments, so a 1-cent move in Sugar is equal to 
$1,120.00 before commissions and fees.  Cocoa contracts call for 
10 tonnes at delivery so a $1 move in Cocoa is worth $10.00 
before commissions and fees.  

Metals:   
Gold, and Platinum prices are quoted in dollars per troy ounce.  
Most quote vendors display there prices in this format as well, so 
prices are easy to read.  A Gold price of 285.10 is $285.10 per 
troy ounce, while a Platinum price of 475.5 is $475.50 per troy 
ounce.  However, each contract has a different contract size.  
Each Gold futures contract represents 100 troy ounces, so a 
$1.00 per troy ounce move equates to $100.00 before 
commissions and fees.  Platinum futures represent only 50 troy 
ounces, as Platinum is much more rare than Gold.  Each $1.00 
per toy ounce move in Platinum is equal to $50.00 before 
commissions and fees. 

Silver and Copper Futures are quoted in cents; cents per troy 
ounce in Silver, and cents per pound in Copper.  For example, a 
Silver price of 452.5 is actually $4.525 per ounce, while a Copper 
price of 70.20 is really $0.7020 per pound.  Each Silver contract 
represents 5,000 ounces; therefore a 1.0-cent move equals 
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$50.00 before commissions and fees.  Copper contracts control 
25,000 pounds of copper; therefore a 1.00-cent move equals 
$250.00 before commissions and fees. 

 

Petroleum:   
Crude oil is quoted in dollars per barrel (bbl).  A price of 20.50 is 
$20.50 per barrel.  Each contract represents 1,000 barrels of oil; 
therefore a $1.00/barrel move is equal to a $1,000.00 profit or loss 
before commissions and fees. 

Heating Oil and Unleaded Gasoline are just like they are at the 
pump (but lower as taxes are not included nor service station 
mark-ups), in cents per gallon.  Therefore a price of 52.46 is 
$0.5246 per gallon.  Both contracts call for delivery of 42,000 
gallons, therefore a 1-cent per gallon equates to $420.00 before 
commissions and fees. 

Currencies:   
Currencies represent an exchange rate, or how many US Dollars 
it take to buy one Swiss Franc, Japanese Yen, Euro, or Mexican 
Peso.  Prices are quoted in many different fashions, but the basic 
convention is that a 0.01 move in the Swiss Franc, or Yen equals 
$12.50 before commissions and fees because of the contract size.  
The Canadian Dollar, US Dollar Index, and Euro have a different 
contract size, and therefore a 0.01 move equates to $10.00 before 
commissions and fees. 

Financials:   
The same basic principles apply to the financial markets, which 
are generally quoted in terms of points.  Prices are usually read as 
is, though some like the treasury securities (US, TY, FV, TU) are 
traded in different combinations of 1/32nd or 1/64th.  Each of 
these markets has the dollars per point already calculated into 
Gecko Software’s Track ‘n Trade application, and a list of the 
different contract sizes and pricing terms are available from the 
various exchanges they trade on, as they do not follow a single 
convention. 

Margins, Cents, Points & the  
Power of Leverage 

Before entering into either a long or short position, one must post 
a performance bond, or have the Initial Margin Requirement 
necessary.  Because it is only necessary to post a fraction of the 
underlying value of the worth of the underlying contract, futures 
are a highly leveraged trading vehicle. 
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Initial Margin Requirements vary from market to market, but 
generally are only 3% to 18% of the value of the underlying 
contract value.   

For example, with March Corn trading at 211 per bushel 
($2.11/bushel), the current initial margin requirement is $405 per 
contract.  Each Corn futures contract represents 5,000 bushels of 
Corn, so the underlying value of a contract of Corn at 211 is 
$10,550.  In other words, for $405 you can control $10,550 worth 
of Corn.  Thus, by putting up just 3.9% of the value of the contract, 
you can control 5,000 bushels of Corn (remember, margin 
requirements are subject to change without notice). 

In the above example, a 1-cent move in the price of Corn ($50.00 
before commissions and fees) represents a 12.3% return on the 
initial Margin Requirement.  This is the power of leverage.  A small 
move in the price of the futures contract can mean a large move in 
your account.  

Another example, a 3.9% move in the price of Corn could yield a 
100% return, double your money, or lose it all, if properly or 
improperly positioned.  The power of trading on margin is that a 
small move in the price of the underlying equates to a large return 
(either positive or negative) on the money posted. 

Just as leverage magnifies the amount of force used, as in the 
case of pulleys allowing men to lift very heavy objects, financial 
leverage magnifies the amount of money, which can be made or 
lost in the markets.  As they say in Chicago… “The futures 
markets have made millionaires of more young men than Rock 
and Roll.” 

However, we want to point out that leverage is a two edged 
sword.  Over leveraging your trading is a sure fire way to lose your 
money…and fast.  Think about the leverage of a roulette wheel.  
Each bet in roulette on a specific number pays off at 35 to 1.  For 
example, if you bet “6” and the ball bounces and lands on “6”, 
every $1 you bet is paid back to you with $35 dollars.  25 to 1 is 
great leverage. 

Now, assume that you start off with $1 and bet “6” and win.  You 
now have $35 and bet it all on “6”, which comes up again.  You 
take your $1,225 winnings and let them ride on “6” again and win, 
reaping $42,875.  “You can win big, even if you don’t bet big” as 
they say…let it ride again, making a phenomenal $1,500,625.  
You let it ride one more time, and up pops “00”.  You loose 
everything. 

Though roulette is strictly a game of chance, the above results are 
possible with futures due to the leverage involved.  For example, 
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you buy 1 Corn futures contract at 210 and the price goes up to 
219, giving you open position profit enough to post margin for a 
second contract.  Prices then rise another .04 cents, and you buy 
a third contract.  With Corn prices having risen .13 cents, you 
were able to buy 3 contracts with an initial investment of only 
$405.00 However, all it takes is a .05 cent decline in the price of 
Corn and all your profits are gone.  Of course another 5-cent rise 
would yield a $1,450.00 profit or a 358% return on the initial 
margin. 

It is possible to make highly leveraged, and possibly highly 
profitable transactions in the futures markets by trading with 
relatively little financial cushion and pyramiding contracts.  
However, it has been our experience that those that practice this 
type of trading generally do not “break the bank” unless of course 
you are referring to your own bank account, which is usually 
drained quickly using this type of money management. 

Most people are attracted to trading futures because of the 
leverage involved, and it is the leverage involved which seems to 
do in most traders.  Though futures trading should only be done 
with genuine risk capital, this does not mean you should take 
undo risk. 

As a general rule of thumb, traders should learn to diversify their 
risk, only placing a small percentage of their capital at risk at any 
one time. 

Though this style of trade will reduce your “bang for your buck” in 
the short run, it may prevent you from getting the “bust for your 
buck” common to many futures traders.  Remember, in order to 
learn this game, you need to be able to stick around to learn all 
the rules (both written and unwritten), and the only way to stick 
around is through prudent money management. 

Orders to Manage Your Future 
The size of your account and the amount of risk you are 
personally able to bear is a completely personal matter.  Some 
very successful traders, like Richard Dennis who is rumored to 
have parlayed $1,000.00 into several million in the futures 
markets, have made fortunes starting with relatively small sums of 
money.  Most professional fund managers risk as little as 1% 
of their account equity on any given trade.  Though both of 
these are probably out of the question for most people starting out 
in the futures market, as the odds of turning $1,000.00 into 
several million in a couple of years is akin to hitting “6” on the 
roulette wheel 5 times in a row. Also, risking 1% of a $1,000 
means only risking $10.00 per trade, which just is not practical.  
However, by maybe postponing your entrance into the futures 
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market until you have, for example, a $5,000.00 minimum of 
genuine risk capital (not the kids college fund, the rent, or your 
next mortgage payment), you could achieve a level of diversity 
and risk, theoretically then risking 10% of your account ($500.00 
before commissions and fees) on any one trade is realistic.  This 
would greatly reduce your risk of ruin, increasing your ability to 
trade longer and hopefully become more proficient in the long run. 

Types of Orders 
At the core of all risk management and trading is using the 
appropriate order for your market objective.  The following are 
some basic definitions of the common order types, all of which 
can be replicated in Gecko Software’s Track ‘n Trade Pro charting 
software. 

The Market Order 
The market order is the most common type of order. With a 
market order the customer states the number of contracts of a 
particular delivery month of a specific commodity he/she wishes to 
buy or sell. The price of the order is not specified, as the market 
order is filled “at the market” or at the current price when the order 
enters the trading pit. Market orders are placed when the 
speculator or hedger wants in or out of the market fast, since time 
is the most important factor in this type of order, not price.  Market 
on Close is a common variation of this type of order, and is used 
when the trader wishes to have his/her order executed during the 
closing of the market (closing range).  The Market on Open is 
another common variation, instructing the order to be filled during 
the markets opening price range. 

The Limit (“Or Better”) Order 
The limit order specifies a price limit at which the order can be 
filled. The limit order can only be filled at the specified price “or 
better”.   For example, a customer wishing to buy two July Corn 
contracts at 210 when July Corn is trading at 211 would place the 
following order: “Buy two July Corn at 210, limit.” 

Buy limit orders must be placed at the current market price or 
lower; this is because when buying you want the lowest price. The 
lower the price the better, and limit orders can only be filled at the 
specified price or lower. Hence one can only place a limit buy 
order at the current price or lower. 

A customer wishing to sell two July Corn contracts at 215 when 
July Corn is trading at 211 would place the following order: “Sell 
two July Corn at 215, limit.” 

Sell limit orders must be placed at the current market price or 
higher; this is because when selling you want the highest price 
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possible. The higher the price the better, and sell limit orders can 
only be filled at the specified price or higher.  

An important note about limit orders is that when a buy limit is 
placed above the market it can turn into a market order, and get 
filled immediately. This is because if the current price is below the 
limit price, the market is in a better situation and it becomes a 
market order. The same principle applies to sell limits: when a sell 
limit is placed below the market, it becomes a market order, as the 
higher market price is better. 

Remember:  Gecko Software’s Track ‘n Trade program helps you 
learn all these rules by allowing you to simulate placing these 
orders, allowing you to practice, and make sure you have each 
order under your belt, before ever moving on to trade the live 
markets. 

Stop Order 
A stop order is not executed until the market reaches the specified 
price level. 

Once the stop level is hit, the stop order becomes a market order. 
Buy stops are always placed above the market, while sell stops 
are placed below the market. 

For example, a customer wishing to buy July Soybeans at 485 
when the current market price is 475 would place a stop order: 
“Buy one July Soybean at 485, stop.” If the Soybean market 
trades as high as 485 or is bid at 485, the order would become a 
market order and would be filled as quickly as possible. 

A customer wishing to sell July Soybeans at 465 when the market 
is currently priced at 475 would place a stop order as follows: “Sell 
one July Soybean at 465, stop.” If the Soybean market traded as 
low as 465 or was offered at 465, the order would become a 
market order and would be filled as quickly as possible. 

Stop orders are usually used to liquidate earlier transactions, to 
cut losses, or protect profits. For example, let’s assume that a 
speculator bought three July Corn at 210 and the market is 
currently trading at 225. He/she may wish to protect some of 
his/her 15-cent profit per contract ($2,250.00 profit before 
commissions and fees) by placing a sell stop at 220, to protect 10 
cents ($1,500 of the profit before commissions and fees). Placing 
the following order would do this: "Sell three July Corn at 220, 
stop." 

There are many other different types of orders, such as stop limits 
and market if touched orders, but the above orders are the most 
commonly used and are really the only orders a beginning trader 
needs to learn. 



Introduction to Futures 

Track ‘n Trade Pro 4.0 User Manual                                                             31 

Look Before You Leap:  
Getting Ready to Start Trading Futures 
Before starting a business it is important to have a business plan 
and have adequate capital. Most new businesses start off with a 
dream, and the proprietors are willing to work hard. Despite the 
hard work, they fail because of unforeseen difficulties, poor 
preparation, or lack of capital.  Remember this when starting your 
trading business, and try to have adequate capital, and plan for 
the unforeseen by developing and testing a trading plan. 

Before trading, it is imperative that you 
develop a trading plan. 

 
Your trading plan should be capitalized with money you can afford 
to lose. Generally trading funds are categorized as genuine risk 
capital if it is money that you can afford to lose.  Again, this is not 
your child’s college education fund, the mortgage money, or 
grocery money. Proper planning and adequate capitalization are 
the cornerstones of any new venture.  

The first step in building a house is drawing up plans for the 
completed house. The workmen who erect the house consult the 
blueprints when placing walls, placing sinks, appliances, and 
electrical outlets. The transition from bare ground to a finished 
home is laid out in the blueprints, or the plan for the completed 
structure. Trades should be planed with as much detail. Every 
situation should be planed for, so decisions are made not in the 
heat of the moment when money is on the line.  

The goal of your trading plan is to allow you to make decisions 
before things happen, giving you a blueprint for trading before 
entering the market. A basic trading plan should include the 
following features as a minimum: 

 Trade entry 
 Initial risk or stop loss point 
 Criteria for stop loss movement 
 Criteria for profitable trade exit 

 
Once you have developed your trading plan, put it to the test by 
“Paper Trading.”  Paper Trading is fictitious trading, or simulated 
trading, best done using Gecko Software’s Track ‘n Trade Pro 
market simulator program, in which you simulate buying and 
selling futures contracts, therefore not risking real money.  The 
whole purpose of paper trading is to be as realistic as possible 
when doing it. It does no good to practice trading with a million 
dollars, if you are going to start with $10,000. Don’t practice your 
trading in the S&P if you are intending to actually trade Corn. 
Keep your practice as realistic as possible. 
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The one major downfall to paper trading is that it does not involve 
real money. It is very easy to live through a fictitious losing streak 
but quite different to live through it when it is your money on the 
line. Because paper trading does not involve real money, your 
emotions are kept at bay, but tend to creep up when real money is 
involved. 

Gecko Software’s Track ‘n’ Trade Pro Charting Program comes 
with over 25 years of historical data on over 50 different markets, 
allowing you to learn the markets and develop a trading plan.  
Four different Plug-in are available for Track ‘n Trade Pro to help 
you maximize your trading strategies.  The Plug-ins are listed 
below: 

Accounting Plug-in - Enables Track ‘n Trade Pro users to 
simulate placing life like orders, applying deposits and making 
withdrawals. Also, it keeps track of commissions paid to your 
simulated (or live) broker, tracks orders placed, profits & losses 
and even simulates margin calls. 

Options Plug-in – The order tools included with this Plug-in 
automatically snap to the different strike prices then it shows you 
the actual dollar value of the option on that particular day.  Track 
‘n Trade Pro users who have this Plug-in keep track of options 
profit and losses concurrent with your futures orders, allowing 
them to practice mixing futures and options strategies 
simultaneously. 

Seasonal Plug-in – Comprised of three indicators for the 
seasonal market, this plug-in assists the Track ‘n Trade Pro user 
to calculate Seasonal Trends, Market Probability, and gives 
Historical Averages.  All this information is based on what has 
happened in the past to a particular seasonal contract.  

Spreads Plug-in - Place orders directly on the spread chart and 
let Track 'n Trade automatically simulate placing both orders in the 
opposing contracts, then calculates your daily profits and losses in 
the Accounting and Simulation Plug-in module. 

So, before ever attempting to trade in the futures market, develop 
a strategic plan.  Your trading plan should be realistic and well 
tested over past history.  Once it has been developed, take six 
months and paper trade; “simulate” trading in “real time”, using 
Track ‘n Trade Pro.  If the plan still holds up, then remember the 
mantra of futures traders: “Plan your Trade, and Trade Your 
Plan.” 

Good Luck, 
Lan H. Turner, CEO 
Gecko Software, Inc. 
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TRACK ‘N TRADE INTRO 

 
This section includes a quick look at Track ‘n Trade Pro features 
and there location in the software. For more information see the 
following sections referenced. 
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File Menu – This menu consists of File, View, and Help. 
 

 
 
The File Menu consists of: 

New: Opening New Chartbook 
Open: Opening a Saved Chartbook 
Save: Saving current Chartbook with existing name, if Chartbook 
has been saved.  If it hasn’t’ the Save As window will open for 
you to name the Chartbook that you are working on. 
Save As: Opens the Save As window allowing you to choose a 
location to save the Chartbook (default My Defaults) and name 
the Chartbook. 
Print: Print the Chart Window.  You will need to click in the Chart 
Window if this option is not available. 
Print Preview: Opens a window showing you what the chart will 
look like when it is printed. 
Print Setup: To change the printer options before printing. 
Download Data: To open the data download utility. 
Exit: Closes the Program. 

 
See the following sections for more information: 

- Creating Chartbooks From Start to Finish 
- Data Downloads 
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The View Menu controls the toolbars that are showing in the software.  
Click on to toggle them on or off.  If a check mark is in front of the 
option it is selected and shown in the software. 
 
Tool Button Lock: This option gives you the ability to lock a tool 
selected until you select another tool. Normally when you click on a 
tool, you draw one item and then the tool ends and you are defaulted 
to the pointer tool. 
 
Program Options: Select this item to open the Program Options 
section. 
 
Commodity Chooser: Select this item to open the Commodity 
Chooser section. 
 
See the following sections for more information: 

- Program Options 
- Data Downloads 
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The Help Menu gives you information about your software needed for 
technical support as well as links for accessing documentation for the 
software. 
 
About Track ‘n Trade: Select to get information about the version 
installed, activation code, and plug-ins installed. 
Online Help: Link to http://help.geckosoftware.com 
Electronic manual: Opens the manual. 
My Account Manager: Open an internet page that you can use to 
update your customer information, payment information, and placing 
additional orders. 
How-To Videos (CD-ROM): Instructions on playing videos. 
Check for Updates: This option is used to check for new updates for 
the software or to update your version of the software to include any 
new plug-ins you may have purchased.  
Change Registration Info: If you mistyped your Activation Code or 
needed to change your code for any reason, click on this option to 
change the Activation code. 
Keyboard Shortcuts: Select to get information on the quick 
reference list of keyboard shortcuts for common commands.  
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Main Toolbar – This menu consists of quick buttons for: Open, New, 
Save, Capture, Print, Preview Print, Commodity Chooser, Program 
Options, Data download, Pointer and Hand Tool.   
 
These features are covered in the following sections: 
- Creating Chartbooks from Start to finish 
- Data Downloads 
 

 
Charting Tools – This toolbar consists of the: Cross-hair, Line, Multi-
Line, 1-2-3, Head & Shoulders, Channel, N%, Inclining/Declining, 
Wedge, and Trend Fan Tools 
 
These tools are covered in the Analyzing Charts with Charting Tools 
section. 
 

 
Advanced Charting Tools – This Toolbar consists of the: Elliot 
Wave, Dart/Blip, Gann Fan, Andrew’s Pitchfork, Fibonacci 
Retracement, Fibonacci Arc, Fibonacci Time Zone, Day Offset, and 
the Arc Tool. 
 
These tools are covered in the Advanced Charting Tools section. 
 

 
Notation Tools – This Toolbar consists of the Arrow, Flag, Text, Box, 
and Circle Tool. 
 
These tools are covered in the Personalizing Charts with Notation 
Tools section. 
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Accounting Tools – This toolbar consists of the Dollar Calculator 
and the Risk/Reward Tool. 
 
These calculators are covered in the using Calculators Section 
 
Control Panel – The Control Panel consists of the Commodity, Key, 
Data and Notes Tabs. 

 
Commodity Tab: This section of the Control 
Panel gives you the ability to open a chart, 
add a chart to your Chartbook, and select 
between the charts that are open.  
 
See the Creating Chartbooks from Start to 
Finish section for detailed information. 
 
Key & Data Tabs: These sections display the 
key details and data from the contract 
displayed in the Chart Window.  
 
See the Data Download section for detailed 
information. 
 
Notes Tab:  This section gives you the ability 
to save notes with charts. 
 
See Personalizing Charts with Notation Tools 
section for detailed information. 
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Chart Window: Section of the software that displays the chart. 
  
Play Controls: These controls consist of the center chart button, and 
the daily, weekly, and monthly chart buttons. 
 

Center Chart Button: This button scales the price bars 
based on the highest/lowest values displayed in the chart 
window. For more information on Scaling, see the Creating 
Chartbooks from Start to Finish section. 
Daily Chart Button: Automatically selected when opening a 
chart. 
Weekly Chart Button: Opens a long-term weekly chart 
based on the daily chart shown. 
Monthly Chart Button: Opens a long-term monthly chart 
based on the daily chart shown. 
 
See the Long-Term Chart section for more information. 
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Indicator Window: Displays the Indicators 
 
See the Indicators section for more information. 
 

 
Indicator Buttons: Used to select the indicators shown in the 
Indicator window 
 
See the Indicators section for more information. 
 

 
Scaling Controls – Gives the user quick access to changing the 
price bar and ruler scaling.   
 
See the Creating Chartbooks from Start to Finish for detailed 
information. 
 

Status Bar - The status bar gives you the cursor location.  You have 
two values displayed:  
- Your mouse position when your mouse pointer is over the     
  Chart Window. 
- The last day shown on the chart. 
- The cursor bar is also available in a floating tool bar see the    
   View menu 



Introduction to Futures 

Track ‘n Trade Pro 4.0 User Manual                                                             41 

KEYBOARD SHORTCUTS QUICK 
REFERENCE 
 
 
CTRL and K   Scroll Chart Up 

CTRL and L   Scroll Chart Down 

CTRL and I   Scroll Chart left  

CTRL and J   Scroll Chart Right 

Page Up   Half Screen Scroll Up 

Page Down   Half Screen Scroll Down 

Ctrl and Page Up  Quarter Screen Scroll Up 

CTRL  and Page Down  Quarter Screen Scroll Down 

I    Step Chart Back 1 Tic  

J    Step Chart Forward 1 Tic 

HOME    Step Chart to Beginning 

END    Step Chart to End of Data 

SHIFT    Highlight Day Under Cursor 

DELETE    Delete Selected Tool 

TAB    Move to next open Chart 

SHIFT and TAB   Move to previous chart 

CTRL    Lock tool to 45 or 90 Degrees 

+     Increment Calculator 

-    Decrement Calculator 

F9    Toggle for text on Chart Pivot 
    Points Indicator 

H    Toggle key for showing the 
    Control Panel 
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TRACK ‘N TRADE PRO 
VERSION 4.0 
 
Accumulating Wealth One Tic at a Time! ® 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

CREATING CHARTBOOKS FROM 
START TO FINISH 
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CREATING CHARTBOOKS FROM 
START TO FINISH 
All you need to know about creating your own 
Chartbooks 
Introduction: 

Just like a novel is made up of many single pages, a Chartbook 
contains many individual charts. Track 'n Trade Pro gives you the 
ability to save charts in one file; which is called a Chartbook.  
Each Chartbook can contain several charts; these charts are like 
the “pages” of your Chartbook. 

Every time you open Track ‘n Trade Pro a blank Chartbook 
named Book1 will open. You can either continue with the new 
Chartbook that is open or you can open a Chartbook that has 
already been created.  

Each chart that you open and view from the Commodities tab is 
listed below in the Active Charts list found on the left side of the 
screen. This list is your "Table of Contents" per say for your 
Chartbook. Charts are listed in Alphabetical order in this window.  
To switch between charts simply double-click on the different 
charts listed.   

Active Charts List in Track ‘n Trade: 
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Opening or Creating a New Chartbook 
After opening Track ‘n Trade Pro, a new Chartbook has already 
been started for you.  It is called Book1.  All this Chartbook needs 
are “pages” or charts added to it.  You can add pages to your 
Chartbook by simply opening charts using the Commodity Tab.  
See below. 

Opening a chart in Track ‘n Trade: 

 

1. Choose your commodity from the dropdown menu. Then choose 
the month and year from the dropdown menu to the right.   

2. Click on the Open Chart button to open your chosen chart.  

Sorting the Commodity List: 
Notice that you have sorting options above the “choose a 
commodity” drop down menus. You can sort commodities by Group 
or Exchange, plus you can display them in an ascending or 
descending order. 

Symbol Search: 
If you know the symbol of the chart that you are opening, you can 
type the symbol into the box after Symbol. A complete list of 
Commodity Symbols and Commodity Month Symbols can be found 
in the Data Download Section.  
 

Adding/Removing Charts in your Chartbook 
Now that you have charts in your Chartbook you might want to 
delete some of the charts you have opened before you save it as 
a Chartbook.  
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To Remove a Chart:  
Simply select on the 
chart by clicking on it, 
then right-click and 
select 
“Delete Chart”.  
 
To Add a Chart: 
Simply open another 
chart using the 
instructions found in 
“Opening a New 
Chartbook”. 
 
 
 
 

Switching between Charts in your Chartbook 
When you have several charts open in Track ‘n Trade Pro, you 
are able to switch back and forth between the charts listed in the 
Active Charts by: 

1. Double-clicking the chart in the Active Charts list.  
2. Pressing the Tab key on your keyboard. 
3. Clicking on the Chart Window Title Bar. (see below) 

  
Saving and Closing a Chartbook 

When you have your Active Chart list the way you want it, you can 
save it as a Chartbook and have it available to open later.   

To Save a Chartbook, click on the File menu and then choose 
Save Book As.  This will open the Save As window.  
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In the Save As window, you will need to note two things:  

First look at the folder specified next to the words Save In. The 
default folder is My Documents; it is recommended that you use 
the default folder unless you are familiar with the directory 
structure of Windows and feel comfortable browsing to other 
folders.  This is the location in which your Chartbook will be 
saved.  

Second, notice the name of your file (Default is Book1.tnt) 
located after File Name. It is recommended that the Chartbook 
be renamed, so as not to accidentally over-write this file the next 
time a file is saved. Some Track ‘n Trade users have named 
Books according to Groups, Commodities, or Exchanges, 
depending on the charts that they are saving in the Book.  As 
you become familiar with Track ‘n Trade, you will soon develop 
a system of your own. 
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Opening an Existing Chartbook 
To open an existing Chartbook click on the Open Folder button 
shown circled in the main Toolbar, or click on the File Menu and 
select Open.  

 
The following screen will appear: 

 
In the Open window, select your file and click on the Open button. 
In the screenshot above the Chartbook is named “Grains.tnt”.  
Another way to access recently saved Chartbooks, is to go to the 
bookmarked section at the end of the File Menu.   
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Saving Charts as an Image 
Many Track ‘n Trade Pro users include Chartbooks and images of 
their charts in emails, websites etc.  To save the current chart as it 
is on your screen to an image follow these instructions: 
 

Step One: Click on the Screen Capture button in the Main 
Toolbar. See below: 

 
Step Two: The Save Chart image window will appear.  In this 
window you may specify: file name, location and file type.  Once 
the image is saved you are ready to email or import this graphic 
into your document. The standard web file types are .gif or .jpg.  
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Printing a Chart 
To print a chart in Track 'n Trade Pro, click on the File Menu and 
select Print.  This will open the Windows Printer Screen for your 
default printer. You can also print a Chart by clicking on the 
Printer button circled below on your main Toolbar: 

 
The printed chart will always have the indicator window printed at 
the bottom of the chart. The size of the chart will depend on the 
size that it is when you press the Print button.   

For an idea of what the chart will look like, click on the  
Print Preview button to view the output before printing the chart.  
Also printed on the chart are the last day’s Open, High, Low, and 
Close. 

Printing Options: 
       
Portrait -  
Prints a half-page chart.   
 
Landscape -  
Prints a full-page chart.  
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Scaling a Chart 
There are many scaling tools available for you use for scaling your 
charts in Track ‘n Trade Pro. Take a look at each individual tool 
and how to use them. 

Auto Scale Charts: 
The Auto Scale Chart feature in Track ‘n Trade Pro forces the 
chart to scale the price bars displayed in the chart window based 
on the highest and lowest point available in this set of price bars. 

If you have the Accounting & Simulator Plug-in, which includes the 
play controls, the Auto Scale Chart feature will re-scale the chart 
each time you click a Play button.  

 
Turning on the Auto Scale Chart 
Feature: 
Right-click on the Chart Window, to see 
the menu shown at the left, and select 
the Auto Scale Chart option. You will 
notice that a check mark will appear 
when this option is selected. 
 
You may also select this feature in the 
Program Options. 
 

 

Sizing Controls: 
 

 
A. The first set of controls scales the vertical height of the price 

bar. 
B. The middle set of controls scales the number of price bars 

displayed per inch on the chart. 
C. The last set of controls scales the days along the bottom of 

the chart and the points displayed on the right side of the 
chart. 
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TRACK ‘N TRADE PRO 
VERSION 4.0 
 
Accumulating Wealth One Tic at a Time! ® 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

DATA  DOWNLOADS 
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DATA DOWNLOADS 
 
Update your Track ‘n Trade Pro Database with 
the simple click of a mouse! 
Introduction 

The Data Download Utility in Track ‘n Trade Pro is simple to use.  
Easily control the commodities that you download with the 
Commodity Chooser and keep current with the Data Utility. 

Commodity Chooser: 
The Commodity Chooser is a utility for managing the available 
commodities. 

To open the Commodity Chooser:  
Click on the View Menu and selecting “Commodity Chooser” or 
click on the Commodity Chooser button on the main Toolbar.  

 
 

Selecting/Deselecting Commodities: 
You may select/deselect futures and options data for each 
commodity by clicking the appropriate check box.  The options 
data is only available if you own the Options Plug-in and the 
Futures & Options Subscription service. 

If you would like to select all futures/options or deselect all 
futures/options data click on the + and – buttons at the end of 
each column. 

Note: Saved Chartbooks containing charts from commodities that 
you have removed from the chart window, will not be affected by 
the Commodity Chooser.  This utility will not delete data from your 
hard drive.  You will still be able to access your previously saved 
charts. The Commodity Chooser will only hide this commodity 
from the Commodity Tab and from the Daily Downloads. 
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Adding Commodities: 
When you add commodities to your data set, the Data Download 
Utility will retrieve any missing historical data for the commodity on 
the next data download. 

Limit Historical Data:  
If you would like to limit the contracts listed in the Commodity Tab 
drop down menu, select the “Limit History to ___ years” and then 
select the number of years that you would like to see in the drop 
down menu. 

Note: This option does not change the amount of data stored on 
your hard drive, it simply controls the data that is displayed in the 
Commodity Tab. If you were to manually type the symbol (in the 
symbol search) to a chart not seen in the menu, it would still be 
displayed.  

Commodity Chooser window in Track ‘n Trade 
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Commodity Symbols 
Track 'n Trade Pro will accept contracts typed in the following 

format:  
Track ‘n Trade Pro Commodity Symbols 

Symbol Name Exchange Group 
+AD Australian Dollar (c) CME / IMM currencies 
AD Australian Dollar (o) CME / IMM currencies 
+BP British Pound, CME (c) CME / IMM currencies 
BP British Pound, CME (o) CME / IMM currencies 

+CD Canadian Dollar, CME (c) CME / IMM currencies 
CD Canadian Dollar, CME (o) CME / IMM currencies 
+EC Euro FX (c) CME / IMM currencies 
+JY Japanese Yen, CME (c) CME / IMM currencies 
JY Japanese Yen, CME (o) CME / IMM currencies 

+MP Mexican Peso (c) CME / IMM currencies 
MP Mexican Peso (o) CME / IMM currencies 
+SF Swiss Franc (c) CME / IMM currencies 
SF Swiss Franc (o) CME / IMM currencies 
RZ Euro/Swiss Franc (e) NYBOT / FINEX currencies 

+DX U.S. Dollar (c) NYBOT / FINEX currencies 
DX U.S. Dollar (o) NYBOT / FINEX currencies 

+NG Gas, Natural (c) NYMEX energies 
+HU Gasoline, Unleaded (c) NYMEX energies 
+HO Oil, Heating (c) NYMEX energies 
+CL Oil, Light Crude (c) NYMEX energies 
+MB Municipal Note 10 yr (c) CBOT financials 
+US U.S. T-Bond 30 yr (c) CBOT financials 
US U.S. T-Bond 30 yr (o) CBOT financials 
+TY U.S. T-Note 10 yr (c) CBOT financials 
TY U.S. T-Note 10 yr (o) CBOT financials 
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+TU U.S. T-Note 2 yr (c) CBOT financials 
TU U.S. T-Note 2 yr (o) CBOT financials 
+FV U.S. T-Note 5 yr (c) CBOT financials 
FV U.S. T-Note 5 yr (o) CBOT financials 

+ED Eurodollar (c) CME / IMM financials 
ED Eurodollar (o) CME / IMM financials 

+EM LIBOR, 1mo (c) CME / IMM financials 
EM LIBOR, 1mo (o) CME / IMM financials 
+C Corn (c) CBOT grains 
C Corn (o) CBOT grains 

+O Oats (c) CBOT grains 
O Oats (o) CBOT grains 

+RR Rice, Rough (c) CBOT grains 
RR Rice, Rough (o) CBOT grains 

+SM Soybean Meal (c) CBOT grains 
SM Soybean Meal (o) CBOT grains 
+BO Soybean Oil (c) CBOT grains 
BO Soybean Oil (o) CBOT grains 
+S Soybeans (c) CBOT grains 
S Soybeans (o) CBOT grains 

+W Wheat, CBOT (c) CBOT grains 
W Wheat, CBOT (o) CBOT grains 

KW Wheat, KCBT (o) KCBT grains 
MW Wheat, MGEX (o) MGEX grains 
+DJ Dow J. IA (c) CBOT indices 
YM Dow J. IASM $5, mini (e) CBOT indices 
+GI GSCI (c) CME / IOM indices 
+ND NASDAQ 100 (c) CME / IOM indices 
NQ NASDAQ 100, mini (e) CME / IOM indices 
NK Nikkei 225 (o) CME / IOM indices 
+RL Russell 2000 (c) CME / IOM indices 
+SP S&P 500 (c) CME / IOM indices 
SP S&P 500 (o) CME / IOM indices 
ES S&P 500 Stock, mini (e) CME / IOM indices 

+MD S&P MidCap 400 (c) CME / IOM indices 
MD S&P MidCap 400 (o) CME / IOM indices 
CR CRB (o) NYBOT / NYFE indices 
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YX NYSE Composite,  
regular old (o) NYBOT / NYFE indices 

+FC Cattle, Feeder (c) CME meats 
+LC Cattle, Live (c) CME meats 
PB Hogs, Frozen Bellies(o) CME meats 
+LH Hogs, Lean (c) CME meats 
DA Milk, fluid class III (o) CME meats 

+HG Copper, High Grade (c) NYMEX / COMEX metals 
+GC Gold (c) NYMEX / COMEX metals 
+PA Palladium (c) NYMEX / COMEX metals 
+PL Platinum (c) NYMEX / COMEX metals 
+SI Silver (c) NYMEX / COMEX metals 
LB Lumber, random length (o) CME softs 

+CC Cocoa (c) NYBOT / CSCE softs 
KC Coffee C (o) NYBOT / CSCE softs 
SB Sugar #11 (o) NYBOT / CSCE softs 
CT Cotton #2 (o) NYBOT / NYCE softs 
Legend for the Commodity Symbols: 
+ Refers to a Combined Contract 
(c) Combined Data 
(o) Open Outcry Session 
(e) Electronic Session 

Commodity Month Symbols: 
Month Symbol Month Symbol 

Jan F Jul N 
Feb G Aug Q 
Mar H Sep U 
Apr J Oct V 
May K Nov X 
Jun M Dec Z 
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Data Download Utility 

 

To perform a Data Download: 
Click on the Data Download icon (shown below) on the main 
Toolbar.  This will open the Data Update Internet Download 
screen.  Notice that the Track ‘n Trade program will close and the 
data download program – “FIDO” will open.   

 
 

Note:  When the program closes, all changes are saved on your 
working charts and will be reopened to the last chart you were 
working on when finished. 

Before opening the Data Update Window, Track ‘n Trade will 
check for product updates.  If one is available you will be notified 
and given a window to choose Yes or No on the update.  It is 
recommended that you install each update as it becomes 
available. After you are finished with the program update, you will 
be returned to the data download window.  

Click on BEGIN to start the data download.  Watch the status bar 
to see the progress of the data download.   
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When the download is complete the following window will appear: 

 
 

Click on “OK” button and then DISMISS to exit the Data Download 
Utility.  You will notice that the bottom Status Bar will display 
DATA CURRENT when finished. 

 

Note:  The Data Download Utility (FIDO) is able to detect the last 
date available in your database.  Therefore, if you add a 
commodity or miss a couple of days, your data will be completely 
updated upon the next data download session. 

To Stop a Data Download: 
If you need to end a data download before it is finished with all of 
the contracts, click on the DISMISS button.  This will signal the 
Data Download Utility to end the download after the current 
commodity is finished.   

Note:  Do not press the power or reset buttons if the Data 
Downloader freezes and you are unable to close the window.  If 
this happens, press the buttons CTRL, ALT, DEL at the same time 
to open the Tasks Screen (Only press them ONCE).  Then Select 
Spot.exe from the window and click on End Task.  This will close 
the Download Program and allow you to restart the program and 
download utility. 
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Data Tab 
 
The Data Tab is the tab with the graphic that looks like a 
spreadsheet.  Click on the tab and it will expand to say “Data” as 
you see in the screen shot below.  This tab is a spreadsheet 
representation of the data available in the specific contract that 
you are currently viewing in the chart window.  The Data Tab has 
values for the date, open, high, low close, volume, open interest, 
and each indicator for each day on the contract. 
 

The left disk button is used to save any changes you have 
made to the data in the Track 'n Trade Pro database so they are 
available the next time you run the software. You can use this 
feature to adjust the open, high, low, close, volume and open 
interest values if you don't agree with them.  
 
Note: If you let Gecko Software Technical Support know about 
the data that seems incorrect, they can research your data 
question and make a correction available on the next data 
download or help you understand why the data is correct.  
 

The disk button with the red arrow on it is for undoing any 
data changes you have made but have not saved. You can 
change a value in Track 'n Trade and see the results of that 
change on your current chart without saving the changes. If you 
mistyped a value, just click this reload button and the data will 
reload from the disk. If you have already saved the incorrect 
value, this action will not recall the original value. In that case, 
just type the correct value in and push the save button. 
The software chooses the most appropriate format for displaying 
the data in the data tab and elsewhere in the software from one 
of three categories: 
 
Decimal 
Most commodities are traded as decimal values and will be 
displayed as a decimal everywhere.  
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Fractional 
Some commodities, notably the CBOT grains, are traded as 
halves (1/2) quarters (1/4) and eights (1/8) and quoted as such 
by the exchanges. Some of these commodities trade in quarters 
but are quoted as though they trade in eights for historical 
reasons. For example Corn, while traded in quarters, is quoted 
as either 3106 or 310-3/4 with both numbers representing the 
same quote. In these 
cases the software will output the quote as 310-3/4 to avoid 
confusion. 

 
 
Short Fractional 
A few commodities, notably the CBOT U.S. Treasury 
commodities, are traded in much smaller fractions such as 
thirtyseconds (1/32) and halves or quarters of thirtyseconds (1/4 
of 1/32). This leads to quotes like 101317 which means 101-
31.75/32. One quarter of one thirtysecond is one hundred and 
twenth eighth (0.25/32 
== 1/128). To keep the data format short yet display the full 
precision of the number the software quotes these numbers as 
101-31.75 and drops the fraction (/32). Where space is more 
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restricted such as the vertical price scroll bar the last digit may be 
truncated to 101-31.7. 

 
 

Key Tab 
 

The Key Tab is the tab with the graphic that looks like a Key.  
Click on the tab and it will expand to say “Key” as you see in the 
screen shot below.  The Key Tab displays the information from 
the exchanges on the contract that you are currently viewing in 
the Chart Window. See what each value represents below. 

Symbol - Gecko Software's 
symbol for the commodity. For 
Track 'n Trade Pro v4.0 we 
have re-done our symbology 
to make our symbols match 
the exchanges as much as 
possible. 

Name - Short name including 
an indication of the session 
type. Types include (o) for 
open outcry and (c) for 
combined. Group - The group 
that Gecko Software has put 
the commodity in. 

Exchange - The exchange 
where the commodity’s trades 
are processed. Sometimes a 
primary exchange will be listed 
with a subsidiary exchange, 
Eg NYMEX/COMEX. 
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Contract Size - The number of units that one contract 
represents. 

Contract Units - The unit measurement. 

Tick Size - A tick is defined by the exchanges as the smallest 
increment the quote of a contract will fluctuate. This is also called 
the minimum move or a point. 

Minimum Move - The tick size is displayed as a decimal value 
instead of a fraction. 

Tick Units - The unit of measure for quotes. This is usually the 
same as the unit the exchange uses. If Gecko Software uses a 
different unit than the exchange, we will adjust the full point value 
so that all accounting is still correct. 

Full Point Value – This value represents how much a move in 
the ones place is worth. For the few commodities that trade in 
whole values this is the same as the minimum move. Generally it 
represents several minimum moves. 

Init. Margin - The initial margin is the amount the Exchange and 
your Brokerage Firm requires you to have available in your 
account at the end of the first day your order is filled in the 
market. 

Maint. Margin - The maintenance margin is the amount of 
available funds required to be in your account at the end of each 
trading day after the first day your order is filled. It is generally a 
smaller amount than the initial margin. 

FND: First Notice Day - Depending on the exchange this date 
can indicate various rules have come into effect. Overall this is a 
warning that the contract will expire soon. This value is different 
per contract and applies to the contract that is currently open in 
the charting window. 

LTD: Last Trading Day - The last day that you can trade the 
contract month that is currently open. 

Market Open - The time that the market opens. This time is the 
exchange's time zone as listed on the exchange's web site. 
Market Close - The time that the market closes. Like market 
open, it is in the exchange's time zone. Time is in 24 hours, so 
13:15 is 1:30PM. (Subtract 12 hours from values greater than 
12:00.) 

Options Expiration - The date that options for the active 
contract will expire worthless or be automatically exercised into 
futures orders. 
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Options Strike Interval – The value for the minimum spacing 
between options, as listed by the exchange. Some contracts 
have rules that make strikes further out of the money or on 
contracts that aren't the next to expire have larger strike price 
intervals. Track 'n Trade auto-generates strikes on all contract 
months at the minimum strike price value. 

Options Min. Move – The value of the minimum price fluctuation 
for the options contract, this is similar in function to the futures 
minimum move. 

No. of strikes above/below: Track 'n Trade Pro v3.0 uses this 
value to know how many strikes above the highest high and 
below the lowest low to auto-generate. If the exchange sends 
data out on strikes outside of these ranges, they are also 
available in the software. 

Below this table is a description of the units used, the 
calculations for the minimum move, and the full point 
movement. 

Importing Data 
Track ‘n Trade Pro gives you the ability to import a day’s worth of 
data to any contract.  To add data, open the contract you would 
like to add the data to and then click on the Data Tab in the 

Control Panel.  Click on the “Add Data” 
button and the Add Data Window will 
open.  This window gives you the ability 
to add the values for the contract’s Open, 
High, Low, Close, Volume, and Open 
Interest for a specified date. 

One day of data can be added to a 
contract, and then a data download must 
be completed before another day can be 
entered. Any data entered through the 
Add Data option, will be overwritten in 
the database by the data downloaded. 

Note:  If the contract you have selected is expired, you will not be 
able to add data to this contract.   
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Exporting Data 
Data subscribers, to Track ‘n Trade Pro, have the ability of 
exporting data as an ASCII file.  There are two ways of exporting 
data: from the software and from the internet. 

Export from the software – In the Commodity Tab right click on 
the contract in the Active Charts list.  A quick menu will open 
giving you the option of Deleting the Chart or Exporting the Data.  
Select the Export Data option and a Save Window will open.  
Type a name in the File name section and then select a save 
location with the Save in drop down menu. This option will save 
your data for the selected contract in a “csv” or “comma separated 
value file.  This file can be opened by a spreadsheet type 
application. 

Exporting from the ASCII Data Download Website – If you are 
interested in downloading multiple Commodities and contracts 
along with customizing the data format, visit the ASCII Data 
Download Website at: http://ascii.geckosoftware.com/ 

Firewalls 
A firewall is a piece of software or hardware that protects your 
computer from other people accessing your computer from the 
Internet.  A firewall only allows basic types of Internet and 
Network communications, such as surfing the Internet.  When you 
log onto the Internet or your network, you are open to attacks from 
other people.  Although attacks are rare, they do pose a big 
enough threat to warrant the protection or a firewall. 

Track ‘n Trade Pro uses a special utility called the “Data 
Downloader” or “FIDO” to download the current market data and 
update the charts.  The Data Downloader does not use 
conventional means to download the data in order to speed up the 
downloading process. Because of this, Track ‘n Trade Pro may 
encounter problems downloading through the firewall.  It may 
appear that the downloader is idle for a long period of time and 
then it will display an error stating it could not find the server.  This 
is because the firewall does not allow the server from sending the 
new data to your computer. 

Track ‘n Trade Pro has a new feature to allow for both standard 
and non-standard methods for downloading data.  The standard 
method uses port 80 which is accepted by most firewalls as 
regular traffic, but this method is slower.  The non-standard 
method uses port 60184 and will need to have an exception made 
in order for this method to work with a firewall; this method is 
much faster than Port 80 in downloading data. 
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Configuring Track ‘n Trade Pro for Firewalls: 
1. Click on the Data Download button from Track ‘n Trade Pro 

toolbar, which will start FIDO, Track ‘n Trade Pro’s Data 
Download Utility.   

2. There is a button located on the far right called “Options”.  
Click this button. 

3. This will open a new window where you can select which 
method to download data.   

4. If you are working behind a firewall, select “Port 80”, and 
then click “OK”.   

5. Once done, click “Begin” to start downloading data. 
 

 


